


























































































2 Choose Preferences from the File menu. 

To choose one of 
these two sizes, 

The Preferences dialog box appears. You can check the current options and 

make any changes you want. 

Preferences 

f Slide Show Size 

click a button. 

To add or remove 
programs in the Using 

pop-up menu, click 
one of these buttons, 
and in the dialog box 

Uiewlng Options To choose another size (resolution), 
open this pop-up menu. 

To choose a program for opening 
Photo CD images, open this pop-up menu. 

that appears, specify -11----L.._-----' 
the program you want 

to add or remove. 
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IMPORTANT If you see an error message when you select a program for 

opening Photo CD images, it means you can' t double-click a n image to open 

it in this program. However, you may still be able to open your Photo CD 

images from within this program by opening the program and then choosing 

the Ope n com mand. (See th e manuals that came w ith your program for 
instructions on opening Ii les from within it.) 

3 After you've chosen the options you want, click OK to close the Preferences dialog box. 

4 Restart your Macintosh. 

Your cha nges take effect after you restar t your Macintosh. Then, whe never 

you double-click a Photo C D image, it opens in the selected program and at 

the resolution and size you specified. 



A note about resolution 

When a Photo CD image is created , it's recorded at five different levels of 

resolution. The resolution level of an image determi nes the amount of 

information recorded for it, which in turn determines how well the image can 

be displayed or printed. The higher the image resolution , the more 

information that is recorded for it. 

High-resolution images can contain as much as 18 MB of data for one 

photograph. However, depending on your computer's screen resolution or 

your printer's printing resolution, you may not be able to view or prin t the 
graphic at such high resolution. 

You can select and work with a n image a t a resolution appropriate for your 

display or printing device. For most work, an image resolution of 768 x 512 
pixels or smaller is suitable. For more detai led work or for very high-q uali ty 

reproduct ions, you may want to use a larger image resol ution. 

You should ope n larger images with application programs designed to handle 

large image files. TeachText and SimpleText will have difficulty opening large 

fil es. 

Working with Photo CD images in other programs 

You can work with your Photo CD images in a variety of programs other than 

the Slide Show, TeachText, and SimpleText. T here are several ways to open 

and work w ith Photo CD images in other programs: 

• You can set a default program so th at when you double-click a Photo CD 

image, the image automatically opens in the program you chose. See 

"Setting Preferences for How Photo CD Images Are D isplayed," earlie r in 

this chapter. 

• You can transfer a di splayed image to the default program or to any other 

program while you are in the Slide Show Viewer. See "Transferri ng the 

Displayed Image to Another Program," next. 

• You can also copy and paste images. See "Copying Images from a Slide 

Show Movie" later in this chapte r. 
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Once you've opened the image in a program, you can change the image and 
save your changes on a hard disk or tloppy disk. You can't save any changes to 
your Photo CD because it is a "read-only" disc. 

Transferring the displayed image to another program 

When you are look ing at an image with the Slide Show Viewer, you can use 
the Photos menu to transfer the image into another program. You can keep the 
current settings in the Preferences dialog box, or you can change them. 

To transfer the image with the current sellings in the Preferences dialog box: 

• While the image you want is displayed, choose View from the Photos 
menu (or double-click on the image). 

The image opens in the program and at the resolution you specified in the 
Preferences dialog box. 

To transfer the image with new settings: 

While the image you want is displayed, choose View As from the Photos menu. 

2 In the dialog box that appears, choose a resolution from the Size pop-up menu. 

Uiew ns ... 

Size:! 768 H 5 12 ...I 

Using: I ~ TeachTeu t "'I 
Add... [ Remoue .•. J 

3 From the Using pop-up menu, choose a program to open the image. 

If the program in which you want to open the image is not in the Using 
pop-up menu, click Add. In the dialog box that appears, specify the program 
you want to add. 

To remove a program from the list, cl ick Remove. In the dialog box that 
appears, specify the program you want to remove. 

4 When you've chosen the options you want, click OK. 

The image opens in the program and at the resol ution you specified. 



Copying images from a Slide Show movie 

You can also copy a Slide Show image and paste it into any document that 
accepts images. 

To copy an image at the current resolution in the Preferences dialog box: 

While the image you want to copy is displayed, choose Copy from the Edit menu. 

2 Open the document you want to paste the image into. 

3 Choose Paste from the Edit menu. 

The image appears in your document, where you can work with it and save it 
on a hard disk or floppy disk. 

To copy the image at a different resolution: 

While the image you want to copy is displayed, choose Copy As from the Edit menu. 

2 In the dialog box that appears, choose a resolution from the Size pop-up menu. 

Copy Rs ... 

Size: I 768 H 5 12 .... I 

[ Cancel J (~J 

3 Click OK. 

4 Open the document you want to paste the image into. 

5 Paste the image into the document. 

T he image appears in the document, where you can work with it and save it 
on a hard disk or floppy disk. 
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Copying a Slide Show movie onto another disk 
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You can copy the Slide Show movie to a hard disk or a floppy disk and use i t 

to browse through and work with the images on the Photo CD. 

IMPORTANT You can't copy a Slide Show movie by dragging its icon to a hard 
disk or floppy disk because there will be no link between the movie and the 

new Photo CD icon. A lthough the icon itself will be copied, you won't be 

able to use the new icon to view the Slide Show movie. 

To copy the Slide Show movie: 

Double-click the Slide Show icon to open it. 

2 Choose Save a Copy from the File menu. 

The Compression Setti ngs dialog box appears. 

3 Select various copy options. 

Specify whether you want color or grayscale images to be copied. If you 

wish, you can also specify a compression method and the quality of the copy. 

4 Click OK. 

5 Choose a location to store the copy and type a name for the copy, then click Save. 

The movie is saved on a hard disk or floppy disk. You can now use this copy 

to view the Slide Show movie. 



Reinstalling CD-ROM Software 
• • • • • • 

In most cases, all the software required for using your CD-ROM drive is 

already installed on your computer and ready to use. Follow the instructions 
in this chapter only if you need to reinstall the software for any reason. To 

check whether you need to reinstall the software, see " Is Your CD-ROM 
Software Already Installed?" in Chapter 1. 

There are different ways to reinstall the CD-ROM software. The meth od you 
use depends on how you received your software: 

• If you have a Performa computer, see "Do You Have a Performa 
Computer?" 

• If your computer came with an inte rnal CD-ROM drive, you also received 
an accessory kit that includes a CD containing your system software. See 

"Reinstalli ng CD-ROM Software From a CD." 

• If you originally purchased your computer without an internal CD-ROM 
drive and later upgraded to add this CD-ROM drive to your system, your 
CD-ROM software is on a fl oppy disk. See " Reinstalling CD-ROM 
Software From a Floppy Disk." 
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Reinstalling CD-ROM software from a CD 
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In the accessory k i t that came wi th your CD-ROM drive i s a CD containing 

your system software. You can use this CD to reinstall the CD-ROM software. 
(To fi nd out if you need to rei nstal l the software. see " Is Your CD-ROM 

Software Already Installed?" in Chapter 1.) In most cases you wil l want to 

reinstall all of the software, and you can follow the instructions in 

·'Reinstall ing A ll the Software." I f for some reason you want to reinstall only 

pan of the software, see "Reinstalling Only Speci fic Parts of the Software." 

IMPORTANT To view Photo COs, you must have the extensions QuickTime 1.6.1 

or later and Apple Photo Access in your System Folder. To check the version 

of QuickTime on your computer or to reinstal l QuickTime, see ':.-\bout the 

QuickTime Extension," later in this chapter. Apple Photo Access is part of the 
CD-ROM software and is installed when you instal l al l the CD-ROM 

software. I f you choose to i nsta ll only part of the softwar e, make sure you 

install the Foreign File System, which contains Apple Photo Access. 

Reinstalling all the software 

I f you need CD-ROM software, you'll probably want to reinstall all the 
software. 

IMPORTANT Do not put the CD containing your system software into th e 

CD-ROM drive unti l after you start up your computer. 

Start up your Macintosh computer, if it's not already on. 

2 Press the Open/Close button to open the tray of the CD-ROM drive. 

-~ 
~- .. ~ 

The tray opens. 



3 Place the CD with your system software in the tray, with the disc label facing up. 

Make sure the disc is lying flat in the tray. 

4 Push the tray in, or press the Open/Close button, to close the tray. 

In a few moments, the disc icon appears o n your screen. 

5 Double-click the disc icon to open it. 

The disc window appears. 

6 Double-click the CD-ROM Setup folder to open it. 

The Installe r icon appears. 

7 Double-click the Installer icon to open it. 

T he Easy Install dialog box appears. 

Easy Install 

Cl ick Install to Place 

Make sure this disk • Macintosh CD- ROM Software 

is where you want on the hard disk named 

the SOftware tO be. --11--= Macintosh liD 

I( Inst all )f---.,- 1- When you're ready to 
begin, click Install. 

Help 

8 Click Install. 

( l.JHI:t [hsk 

1 swit ch Disk 1--1- To switch to a different 
__ __ disk, click Switch Disk 

( Customize ) 

Quit 

until the name of the 
correct disk appears. 

The req uired fi les are automatica lly installed and placed in the System Folder 

on the selected hard disk. 

9 When you see a message reporting that installation was successful, click Restart. 

Your Macintosh restarts. You can now use your CD-ROM drive. (If' a message 

reports that installation was not successful, follow the instructions on screen 
to try installing the software agai n.) 
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Reinstalling only specific parts of the software 

When you need only specific parts of the CD-ROM software, follow these 

instructions to do a custom installation. If you want to use audio COs, 

Photo COs, or ISO 9660/High Sierra discs, you must install both the 

CD-ROM System Driver Software and the Foreign File System. 

IMPORTANT Do not put the CD containing your system software into th e 

CD-ROM drive unti l after you start up your computer. 

Start up your Macintosh computer, if it's not already on. 

2 Press the Open/Close button to open the tray of the CD-ROM drive. 

3 Place the CD with your system software in the tray, with the disc label facing up. 

Make sure the disc is ly ing flat in the tray. 

4 Push the tray in, or press the Open/Close button, to close the tray. 

In a few momen ts, the disc icon appears on your screen. 

5 Double-click the disc icon to open it. 

The disc window appears. 

6 Double-click the CD-ROM Setup folder to open it. 

The Installer icon appears. 

7 Double-click the Installer icon to open it. 

The Easy Install dialog box appears. 



8 Click Customize. 

Click to select the files 
you want installed on 

the selected hard disk. 
(Your software choices 

may be different 
from these.) 

9 

-

Your installation choices appear. 

Click the i t ems you w an t to se lect; 
Shift - click to select mul tiple items. 

CO- ROM Sys tem Dr luer Software 0 
- Foreign File Sys t em 

AppleCO Audio Player Soft wore for System 6 
AppleCO Audio Player Soft wore for System 7 

0 

[ lnstnll 

= Macintosh HO 

( [,I<H:I lllsk l 
I Sw i t ch Disk 

( Easy Ins ta ll ) 

( Quit l 

When you're ready to 
begin, click Install. 

Make sure this disk 
is where you want 
the software to be. 

To switch to a different 
disk, click Switch Disk 
until the name of the 
correct disk appears. 

From the list in the dialog box, select the portions of the software you want to install. 

As you select an item, a description of that item appears below the list of 
items. To select more th an one item to install, hold down th e Sh ift key as you 

cl ick. 

Be sure to select the software appropriate for your computer's version of 

system software. (To check the version of system software you have, go to the 

Finder, pull down th e Apple [ei] menu, and select "About Thi s Macintosh." 

You'll find the version number in the w indow that appears.) 

10 Click Install. 

The selected files are automatically insta lled a nd placed in the System Folder 

on the selected hard disk. 

11 When you see a message reporting that installation was successful, click Restart. 

Your Macintosh restarts. You can now use your CD-ROM drive. (If a message 
reports that installation was not successful , follow the instructions on screen 

to try installing aga in .) 
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Reinstalling CD-ROM software from a floppy disk 
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If you originally purchased your computer wi thout a CD-ROM drive and 

later upgraded to add this CD-ROM drive to your system, your CD-ROM 

software is on the CD Setup floppy disk. You can use this disk to reinstall the 

C D-ROM software. (To fi nd out if you need to reinstall the software, see 
" Is the CD-ROM Software Already Insta lled?" in C hapter 1.) In most cases 

you will want to reinstall a ll of the software, and you can follow the 

instructions in "Re install ing All the Software." If for some reason you 

want to rei nsta ll only part of the software, see "Reinstall ing Only Specific 

Parts of the Software." 

IMPORTANT To view Photo COs, you must have the extensions QuickTime 1.6.1 

or later and Apple Photo Access in your System Folder. To check the version 

of QuickTime on your computer or to reinsta ll QuickTime, see ''About the 

QuickTime Extension," later in this chapter. Apple Photo Access is part of the 

C D-ROM software and is installed when you install al l the C D-ROM 

software. If you choose to install only part of the software, make sure you 

in sta ll th e Fo reign Fi le System, which contains Apple Photo Access. 

Reinstalling all the software 

If you need CD-ROM software, you' ll probably want to insta ll a ll the 

software. 

Insert the CD Setup disk into the internal floppy disk drive. 

If your Macin tosh has two floppy d isk drives, you can use either one. In a few 

moments, the disk icon appears on your screen. 

2 Double-click the disk icon to open it. 

T he di sk window appears. 



3 Double-click the Installer icon to open it. 

The Easy In stall dialog box appears. 

Eosy lnstoll 

Cllctc Install to Place i 

• Moclntosh CO- ROM Sortwnre 

on the hord dlstc nomed 
Make sure this disk -!If--= Moclntosh HD 

J When you're ready to 
11:'1( """""1n=st=at=1 ""\\) 

1 

f- begin, click Install. 

is where you want 
the software to be. 

Help 

( I.JCll:t lhsk 

1 swit ch Disk l-- f- To switch to a different 
____ disk, click Switch Disk 

( Customize J 

Quit 

until the name of the 
correct disk appears. 

4 Click Install. 

The required files are automatically installed and placed in the System Folder 

on the selected hard disk. 

5 When you see a message reporting that installation was successful, click Restart. 

Your Macintosh restarts. You can now use your CD-ROM drive. (If a message 

reports that in stallation was not successful , follow the instructions on screen 

to try in stalling th e software again .) 

Reinstalling only specific parts of the software 

Wh en you need only specific parts of the C D-ROM software, follow these 

instructions to do a custom installat ion. 

IMPORTANT To use audio COs, Photo COs, or ISO 9660/High Sierra discs, 
you must install both the C D-ROM System Driver Software and the Foreign 

File System. 
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Insert the CD Setup disk into the internal floppy disk drive. 

If your Maci ntosh has two fl oppy disk drives, you can use either one. In a few 

moments, the disk icon appears o n your screen. 

2 Double-click the disk icon to open it. 

The disk wi ndow appears. 

3 Double-click the Installer icon to open it. 

The Easy Install dialog box appears. 

4 Click Customize. 

Click to select the files 
you want installed on 

the selected hard disk. 
(Your software choices 

may be diHerent 
from these.) 

5 
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-

Your installation cho ices appear. 

Click the Items you want to selec t; 
Shirt- click to select mult iple i t em s. 

CD- ROM Syst em Drluer Software 0 
- Foreign File System 

RppleCD Rudio Player Software for System 6 
RppleCD Audio PI eyer Software for System 7 

<> 

[ Ius IIlii 

= Macintosh liD 

( £jm:l Ulsk ) 

l Switch Disk 

--
( Easy Install ) 

( Quit ) 

When you're ready to 
begin, click Install. 

Make sure this disk 
is where you want 
the software to be. 

To switch to a different 
disk, click Switch Disk 
until the name of the 
correct disk appears. 

From the list in the dialog box, select the portions of the software you want to install. 

As you select an item, a description of that item appears below the list of 

items. To select more than one item to insta ll , hold down the Shift key as you 

cl ick. 

Be sure to select the software appropriate for your computer's system software 
version. (To check the system software version you have, go to the Finder, pull 

down th e Apple [ti] men u, and select "About This Macintosh." You' ll find the 
version number in the wi ndow that appears.) 



6 Click Install. 

The selected fil es are automatically insta lled and placed in the System Folder 

on the selected hard disk. 

7 When you see a message reporting that installation was successful, click Restart. 

Your Macintosh restarts. You can now use your CD -ROM drive. (If a message 

reports that installation was not successful, fo llow the instructions on screen 

to try install ing agai n.) 

Do you have a Performa computer? 

If you have a Performa compu ter and you need to reinstall the CD-ROM 

software for any reason, you can use the backup copy of your software. (To 

fi nd out if you need to re insta ll the software, see " ls Your CD-ROM Software 

Already Insta lled?" in Chapter 1.) See the manuals that came with your 

computer for further instructions on making and using backup copies of your 

software. 

If you do not have a backup copy o r you cannot use your backup copy, contact 

Apple to get information on obtaining the CD-ROM software. See the service 

and support information that came with your computer for detai ls. 
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About the Quicklime extension 
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To view images on Photo COs, you must have QuickTime 1.6.1 or later. 

Seeing if QuickTime is installed 

Double-click your startup hard disk icon to open it. 

2 Double-click the System Folder to open it. 

3 Double-click the Extensions folder to open it. 

If the QuickTime icon is in the wincloH{ you know QuickTime is in sta ll ed. Go 
on to "Seeing if You Have the Correct Ve rsio n of QuickTime," next in th is 

section. 

If the QuickTime icon is not in rhe windmv, you know QuickTi me is not 

installed. See "Determining How You Should Install QuickTime" in th is 

section. 

Seeing if you have the correct version of QuickTime 

In the Extensions folder window, select the Quicklime icon. 

If you don't see this window, see "Seeing if QuickTime Is Installed." 

2 Choose Get Info from the File menu. 

A window appears with the name and version of the software. If you have 

QuickTime 1.6.1 or later, you do not have to rei nstall QuickTime. If you do not 
have QuickTime 1.6.1 or later, you must install it. (See "Determi ning How 

You Should Insta ll QuickTime," next in this section.) 

Determining how you should install QuickTime 
• If you have a Performa computer, use the backup copy of your software to 

re insta ll QuickTime. If you do not have a backup copy, contact Apple to get 
info rmation on obtaining the Qu ickTime software. 

• If you have a CD with your system software on it, see "Install ing 

QuickTime From a CD" next in this section. 

• If you have a QuickTime fl oppy disk, see "Installing QuickTime From a 
Floppy Disk" in this section. 



Installing Quicklime from a CD 

The accessory kit that came with your CD-ROM drive includes a CD that 
contains your system software. You can use this CD to install QuickTime. (To 
find out if you need to install QuickTime, see "Seeing if QuickTime Is 
Installed.") 

Follow these instructions to install the QuickTime extension. 

Press the Open/Close button to open the tray of the CD-ROM drive. 

2 Place the CD with your system software in the tray, with the disc label facing up. 

Make sure the disc is lying flat. 

3 Push the tray in, or press the Open/Close button, to close the tray. 

In a few moments, the disc icon appears on your screen. 

4 Double-click the disc icon to open it. 

The disc window appears. 

5 Double-click the Quicklime folder to open it. 

6 Click the Quicklime extension icon to select it, and then drag the icon to your System 
Folder icon. 

A message appears saying that QuickTime must be placed in the Extensions 
folder. 

7 Click OK. 

The correct version of QuickTime is installed in your System Folder. 

8 Restart your Macintosh. 
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Installing Quicklime from a floppy disk 

If you origi nally purchased your computer without a CD-ROM drive and later 
upgraded to add this CD-ROM drive to your system, you received the 

QuickTinze floppy disk, which you can use to install the QuickTime extension. 
(To find out if you need to install QuickTime, see "Seeing if QuickTime Is 
Installed.") 

Follow these instructions to install the QuickTime extension. 

Insert the QuickTime disk into the internal floppy disk drive. 

If your Macintosh has two floppy disk drives, you can use either one. In a few 
moments, the disk icon appears on your screen. 

2 Double-click the Quicklime disk icon to open it. 

The disk window appears. 

3 Click the Quicklime extension icon to select it, and then drag the icon to your System 
Folder icon. 

A message appears sayi ng that QuickTime must be placed in the Extensions 

folder. 

4 Click OK. 

The correct version of QuickTime is installed in your System Folder. 

5 Restart your Macintosh. 



Troubleshooting 
• • • • • • 

This chapter describes solutions to problems you may encounter while using 
your CD-ROM drive. 

Many problems can be caused by improper installation of the CD-ROM 
software. If you have to reinstall the software, make sure you install it exactly 
as described in Chapter 4. 

If the suggestions in thi s chapter don't solve your problem, refer to the service 

and support information that came with your computer for information on 
obtaining technical assistance. 
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Problems starting up your computer 
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The computer doesn't seem to know that there is an internal CD-ROM drive. 

• Make sure the CD-ROM software that came with your CD-ROM drive 
is insta lled. (See "Is the CD-ROM Software Already Installed?" in 

Chapter 1.) 

• If you reinstall the CD-ROM software, ma ke sure to restart your computer 

after you reinstall the software. 

• Do you have other SCSI devices attached to your computer? Make sure that 
each SCSI device attached to your computer has a unique SCSI ID number. 
You should not have two CD-ROM drives with the same SCSI number. The 
SCSI ID number of your internal CD-ROM drive is 3. The ID number for 
other Apple devices often appears on the back near the SCSI ports. Refer to 
the manuals that came w ith your other SCSI devices if you need to reset 

SCSI ID numbers. 

The computer won't restart after you've copied software for your CD-ROM drive to the 
System Folder. 

• If you attempt to reinstall the software for your CD-ROM drive w ithout 
using the Insta ller as described in Chapter 4, you may not be able to restart 
your computer. Remove any files you copied by dragging them to the 
Trash. Restart using another startup disk, and then reinstall the software 
according to the instructions in C hapter 4. 

Your computer won't restart and there is a CD-ROM disc inside the CD-ROM drive. 

• Your computer may be trying to restart from a CD-ROM disc other than 
the CD containing your system software. Press the Open/Close button on 
the front of the computer to open the tray, and remove the CD-ROM disc. 
Push the tray in, or press the Open/Close button, to close the tray. Restart 
your computer. 

Your computer starts up and you see large folder-shaped areas, containing labeled 
pictorial buttons, instead of the usual Macintosh desktop. 

• If you start up your computer when the CD containing your system 
software is in the CD-ROM drive, your computer uses the CD as a startup 
disk and you see At Ease, an a lternative to th e usual Macintosh desktop. 
You need to have the usual Macintosh desktop on your screen before you 
can use the installation instructions in this manual. 



To return to the usual Macintosh desktop, choose Shut Down from the 
Special menu. When your computer is off, press the Open/Close button of 
your CD-ROM drive to open the tray, then remove the CD containing your 
system software. Push the empty tray in, or press the Open/Close button, to 

close the tray. Then start up your computer again. 

Problems using CD-ROM discs 
The tray of your CD-ROM drive won't open. 

• Press the Ope n/Close button for your CD-ROM drive. 

• The signal to open the tray may not be reaching the compute r. Turn off 
your computer and locate the small pinhole to the lower right of the 
CD-ROM tray opening. Insert the end of a large straightened paper clip 
firmly and horizontally into the pinhole. Push gently until the tray is 
released, the n carefully pull the tray open. Do not force the tray open; wait 
until the paper clip has dislodged it or you may break the front of the tray. 

WARNING Turn off your computer before you attempt to eject the tray 
using a paper cl ip. If you don' t turn off the computer, you may damage 
the CD-ROM drive. 

• If ne ither of these suggestions works, your CD-ROM drive may be 
damaged . Contact an Apple-authori zed service provider or Apple fo r 

furth er assistance. 

You insert a CD-ROM disc, but its icon doesn't appear on the Macintosh desktop. 

• Make sure you place the disc in the tray with the disc label facing up so 
you can read it. 

• Make sure the tray is closed a ll the way. 

• Make sure the CD-ROM software is installed. (See "Is the CD-ROM 
Software Already Installed ?" in C hapter 1.) 

• Try restarting your computer. 
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Your computer displays the message "This is not a Macintosh disk: Do you want to 
initialize it?" when you insert a CD·ROM disc in the CD-ROM drive. 

• Make sure the CD-ROM software is installed. (See "Is the CD-ROM 
Software Already Installed?" in Chapter 1.) 

• The disc may use a format that the Macintosh cannot recognize. (See 
"Modes Supported" in the Appendix for more information.) 

Your computer ejects a CD·ROM disc without giving you any error message. 

• Make sure you've inserted the disc correctly in the tray (with the disc label 
facing up and the disc lying flat). 

• Your computer may not be able to read information from the disc because 
the disc needs to be cleaned . (See "Care and Handling" in Chapter 1.) 

• If these suggestions don't work, the CD-ROM disc is probably damaged 
and needs to be replaced. 

You can't open a document on a CD-ROM disc. 

• Try opening the application program first; then open the document. 

• Read the manual that came with your CD-ROM disc. Some discs come 
with a separate floppy disk containing the program that reads the 

information from the disc. 

You can't save changes you make to information on a CD-ROM disc. 

• CD-ROM is a read-only medium. This means that information can be read 
(retrieved) from it, but not written (stored) on it. You can save the changed 
information on a hard disk or floppy disk. 

Problems using ISO 9660 or High Sierra discs 
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You cannot access files on a CD-ROM disc that uses the ISO 9660 or High Sierra format. 

• Discs in the ISO 9660 and High Sierra disc formats have version numbers 
attached to filenames. Some application programs need these version 
numbers in order to work with fi les. To make the version numbers 

avai lable to programs on your computer, follow these instructions. 

Drag the CD icon to the Trash. The tray opens. Hold down the Option key 
and push the tray back in ; continue holding down the Option key until the 
disc is in the drive. The program you are using should now be able to 
locate filenames on that CD-ROM disc. 



Problems playing audio COs 

You don't hear any sound when you play an audio CD or an audio track on a CD-ROM 
disc using the AppleCD Audio Player or CD Remote. 

• If you have headphones or speakers connected to the computer, adjust the 

connector to make sure you have a good connection. 

• If you do not have headphones or speakers connected to the computer, 

make sure that nothing else is plugged into the sound output port on the 
back of your computer. 

• Are you using a CD-ROM disc over a network? You can' t hear the audio 

portion of discs you access over a network. 

• Make sure the volume is turned up in the AppleCD Audio Player or CD 

Remote. Pull down the Apple (el) menu and select your audio CD software. 

When the player window opens, drag the volume lever to adjust the sound. 

• Click the Play/Pause button once or twice. You may be in Pause mode. 

• If your Macintosh has different sound recording options, you may have the 

options set incorrectly to hear the audio sound from a CD. Open the Sound 

control panel by pulling down the Apple (el) menu, choosing Contro l 

Panels, and double-clicking the Sound control panel icon. Choose Sound 
In fro m the pop-up menu at the top of the panel, then select the Built-In 

icon for the audio source. C lick the Options button , select Internal CD, 

make sure the Playthrough box is selected , and then click OK. See the 

manuals or on-screen help that came with your computer for more 

information. 

You can't open a track icon on an audio CD or on a CD-ROM disc with audio tracks. 

• If you have CD Remote, you can' t play audio tracks by opening track icons. 
Open and use the CD Remote software to play aud io tracks. 

While playing an audio track on a CD-ROM disc that combines audio tracks and data, 
you double-click the disc icon and the audio track stops playing . 

• You can't ope n data files on a CD-ROM disc and listen to audio tracks on 
that disc at the same time. 
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You are unable to record sound from an audio CD. 

• Check your computer's sound input port to see if a microphone or other 
device is connected. Connecting a microphone or other device to the port 
turn s off the computer's abi li ty to record from your CD-ROM drive. 

Problems using Photo COs 

58 Chapter 5 

Your CD-ROM drive will not open Photo COs. 

• To view Photo CD images, you must have QuickTime 1.6.1 or later and 
Apple Photo Access installed in your Syste m Folder. To check the version 

of QuickTime on your computer or to reinstall QuickTime, see '~bout the 
QuickTime Extension" in Chapter 4. 

Apple Photo Access is part of the CD-ROM software and should al ready 
be ins talled. If you need to reinstall Apple Photo Access, you wi ll probably 

wa nt to reinstall all the CD-ROM software. If you choose to reinstall on ly 
specific p<uts of the software, make sure you install the Foreign File 
System, which contains Apple Photo Access. For more information on 
reinstalling the CD-ROM software, see Chapter 4. 

Your computer does not display color icons for individual images on a Photo CD. 

• Your syste m may be low on memory. Although individual icons may 
appear as black-and-white document icons, the Photo CD images 
themselves are no t affected. To view color icons for individual images, quit 

all open programs, restart your computer, and the n reopen the Photos 
fo lder. See the manuals or on-screen help that came with your computer 

for more information on managing memory. 

After you open an image on a Photo CD, the image is scrambled, colors are displayed 
incorrectly, or no image appears in the window. 

• The program you are using to view the image may have difficulty opening 
large (high-resolution) image files. You can change th e program that opens 
images or you can inc rease the memory a program uses. To select another 
program to open images, see "Setting Pre ferences for How Photo CD 
Images Are Displayed" in Chapter 3. To change th e amount of memory a 
program uses, see the manuals or on-screen help that came w ith your 
computer. 



After you open an image on a Photo CD, your system is "frozen" and does not respond 
to any input, or you have a "bomb" message on your screen. 

• Restart your Macintosh by pressing the reset switch on your computer. If 
your computer doesn't have a reset switch, hold down the~. Control, and 

Power keys to restart the computer. The program you are using to view the 
image may have difficulty opening large (high-resolution) image fil es. You 

can change the program that opens images or you can increase the memory 
a program uses. To select another program to open images, see "Setting 
Preferences for How Photo CD Images Are Displayed" in Chapter 3. 
To change the amount of memory a program uses, see the manuals or 
on-screen help that came with your co mputer. 

WAfiNlNG If you have a problem with your CD-ROM drive and nothing 
in this chapter solves it, see the service and support information that 

came with your computer for instructions on how to contact an Apple­
authorized service provider or Apple for assistance. If you attempt to 
repair the CD-ROM drive yourself, any damage you may cause to your 

equipment will not be covered by the limited warranty on your 
equipment. Contact an Apple-authorized dealer or service provider for 
additional information about this or any other warranty question. 
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Appendix 
Specifications 

• • • • • • 

Disc 
• Data surfaces 

• Disc diameter 

• Disc center hole diameter 

• Thjclcness 

• Track pitch 

• Scanning velocity 

• Rotation speed 

Normal speed 

Double speed 

• Latency (average) 

Normal speed 

Double speed 

• Blocks per rotation 

• Average access time (typical) 

Normal speed 

Double speed 

120 millimeters (mm) 

15 mm 

1.2 mm 

1.6 microns (15,875 tracks per inch) 

1.2- 1.4 meters per second 

Varies over radius 

-530 to 230 revolutions per minute 
(rpm) 

-1060 to 460 rpm 

Varies over radius 

-55 to 130 milliseconds (ms) 

-27.5 to 65 ms 

-8.4 to 19.5 variable 

410 ms 

295 ms 
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Data 
• Data capacity 

• Number of blocks per disc 

• Data per block 

• Address description 

Audio capacity 
• Playi ng time 

Modes supported 
• Audio CD 

• CD-ROM 

• CD-ROM XA 

• CD-I 

• Photo CD 

Data streaming and transfer rates 
• Blocks per second 

Normal s peed 

Double speed 

• User kilobytes (K) per second 

Normal speed 

Double speed 

• SCSI bus burst rate (typical) 

Asynchronous 

Synchronous 

656 megabytes (MB), Mode 1 

748MB, Mode 2 

336,150 

2048 bytes, Mode I 

2336 bytes, Mode 2 

M inutes, seconds, blocks 

74 minutes a nd 42 seconds 

Modes l and 2 

Mode 2, Forms I a nd 2 

Mode 2, Forms I and 2 

Single session and multisession 

75 

ISO 

ISOK, Mode J 

171.1 K, Mode 2 

300K, Mode I 

342.2K, Mode 2 

2.5 MB per second 

2.1 MB per second 



Environmental 

Noise (maximum) 

• Drive on (seek) 

• Drive on (non-seek) 

• Tray open/close 

Temperature 

Celsius (C) and Fahrenheit (F) 

• Operating temperature 

• Storage ( 6 months) 

• Transient (72 hours) 

Humidity 

• Operating 

• Storage 

Altitude 

Meters (m) and feet (ft.) 

• Operating 

• Shipping, non-operating 

Power requirements 

• Voltage 

Power consumption (typical) 

• +5V DC 

• +12V DC 

<50 decibels (dB) 

<46dB 

<55 dB 

5° to 55° C ( 41 o to 131° F) 

-30° to 50° C ( -22° to 122° F) 

-40° to 65° C ( -40° to 149° F) 

5% to 90% noncondensing 

5% to 95% noncondensing 

-305 to 3048 m 

( -1000 to 10,000 ft.) 

-305 to 15,240 m 

( -1000 to 50,000 ft.) 

+5V DC ±5% 

+l2V DC± 10% 

450 milliamperes (rnA) 

420mA 
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Type 

• Semiconductor GaAIAs laser 

Wavelength 

• 790 ± 25 nanometers 

Output power 

• 0.2 milli watts 

Beam divergence 

• 55° 

Note: Some of the specifications listed above could change. 



Index 
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X- Controi-Power key, for restarting 
computer 59 

x-E, for ejecting a CD-ROM disc 5, 13 
X- Option key, for creating 

Photo CD icon 30 
X-Q (Quit) 

in AppleCD Audio Player 19 
in CD Remote 26 

x - W (Close) 

A 

in AppleCD Audio Player 19 
in CD Remote 26 

AB bunon (CD Remote) 22,23 
altitude specifications 63 
Apple-authorized service provider, 

contacting 59 
AppleCD Audio Player (Apple menu) 

checking for presence of 3 
closing II 
Options menu 16 
quitting 19 
reinstalling 3-4, 44-45 
starting up 10-ll 
troubleshooting in 57-58 
using 11 - 19 

If you can't find what you're looking for 

in this index, look in Macintosh Guide­

available In the Guide (l7l) menu 

on your computer. 

AppleCD Audio Player window I 0 
basic controls 12- 1 5 
closing 15 
ejecting disc in 5 
opening 10 

Apple menu 
audio software in. See AppleCD 

Audio Player; CD Remote 
checking for CD-ROM installation 3 

Apple Photo Access 
for Photo CD viewing 3, 29 
reinstallation and 42, 58 

arrow keys, in AppleCD Audio Player 
as Previous/Next track button 

alternatives 13 
as Volume control alternative 13 

At Ease 54 
audio 

file-sharing feature and 8 
problems with 57-58 

Audio CD icon lO 
copying caution 20 
ejecting discs with 21 

audio CDs 9-26 
compatibility with CD-ROM drive 

l, 3 
problems playing 57 
problems recording from 58 
software for 9. See also AppleCD 

Audio Player; CD Remote 
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Audio channel buttons (CD Remote) 22 
audio hardware 9 
audio specifications 62 
audio track icons 

in AppleCD Audio Player, 
playing by opening 18 

in CD Remote 20 
copying caution 20 

audio tracks 

B 

CD-ROM drive capability 9 
copying caution 18 
creating Play List for 

in AppleCD Audio Player 17- 18 
in CD Remote 24-25 

data files and 57 
listening to in background 19 
playing by opening track icon 18, 57 
problems playing 57-58 
renaming, in CD Remote 24, 25 
repeating, in CD Remote 22,23 
selecting, in AppleCD Audio Player 

11, 13, 14 
with Left/Right Arrow keys l 3 
with Previous/Next track 

buttons 13 
with Tracks pop-up menu 14 

viewing playing time for 18 

"bomb" message 59 
browsing Photo CD images 34-35 

c 
CD-1 mode support 62 
CD Remote (Apple menu) 

checking for presence of 3 
controls in 20-24 
creating Play List in 24-25 
multiple CD-ROM drives and 19 
quitting 26 
reinstalling 3-4 
renamjng an audio track in 24, 25 
starting up 10-11, 19 
troubleshooting in 57-58 
using 19-26 

CD Remote window 11, 20 
closing 26 
opening 10-ll 

CD-ROM disc icon 
appears on desktop 10 
does not appear on desktop 55 
opening tray with 5 

CD-ROM discs 
capacity of 2 
cleaning 7 
creating Play List for 

in AppleCD Audio Player 17-18 
in CD Remote 24-25 

ejected by computer 56 
ejecting 5-6 

in AppleCD Audio Player 12, 13 
in CD Remote 21 

file formats on 2 
handling 7 
inserting in dri ve 4-5 

problems with 55 
listening to in background 19 
on network 8 

audio problems 8, 57 
ejecting problems 5 

non-audio tracks on 20 
problems opening document on 56 
renaming 24 



safety considerations 7 
saving changes to information on· 56 
specifications 61 
storing 6 
troubleshooting 55-56 
types of 2-3 

CD-ROM drive 
ejecting a disk from 5-6 
inserting a disc in 4-5 
multisession disc capability in 28 
Photo CDs won't open on .58 
problems with 55 
safety considerations vii, 6-7 
troubleshooting 55 
type of discs handled by 1 

CD-ROM mode support 62 
CD-ROM Setup folder 43, 44 
CD-ROM software 

checking for presence of 3 
reinstalling x, 41-52 

from CD Setup floppy disk 46-49 
on Performa computers 49 
specific parts of 44-45,47-49 
startup problems after 54-55 
from system software CD 42-45 

system software and ix-x 
CD-ROM XA format 2, 62 
CD Setup floppy disk, reinstalling 

CD-ROM software from 46-49 
cleaning CD-ROM discs 7 
cleaning the CD-ROM drive lens 6 
Clock button (AppleCD 

Audio Player) 12 
close box 

in AppleCD Audio Player 15, 19 
in CD Remote 26 

Close (File menu) 
in AppleCD Audio Player 19 
in CD Remote 26 

closing the AppleCD Audio Player 
11, 19 

closing the AppleCD Audio Player 
window 15 

closing CD Remote 26 
color options, in AppleCD 

Audio Player 16 
Command-Control-Power key, 

for restarting computer 59 
Command-E, for ejecting CD-ROM disc 

5,13 
Command-Option key, for creating 

Photo CD icon 30 
Command-Q (Quit) 

in AppleCD Audio Player 19 
in CD Remote 26 

Command-W (Close) 
in AppleCD Audio Player 19 
in CD Remote 26 

communications regulation information 
vi-vii 

compact discs, audio. See audio COs 
Compression Settings dialog box, for 

copying Slide Show movies 40 
Copy (Edit menu), in Slide Show 

Viewer 39 
Copy As (Edit menu), in Slide Show 

Viewer 39 
copying Photo CD images 33, 39 

from Slide Show movies into 
documents 39 

customized Play List 
in AppleCD Audio Player 17-18 
in CD Remote 24-25 

customizing CD-ROM software 
installation 

from CD Setup floppy disk 47-49 
from system software CD 44-45 
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D 

data files on CD-ROM disc, 
audio tracks and 57 

data specifications 62 
data streaming specifications 62 
data transfer rates 62 
Delete key, as Stop button alternative 

(AppleCD Audio Player) 13 
desktop, At Ease instead of 54 
Disc Elapsed Time option 12 
Disc Remaining Time option 12 
discs. See CD-ROM discs; 

floppy disk; hard disk 
DOC Class B compliance vii 
documents 

copying Photo CD images to 39 
problems opening 56 

Down Arrow key, as Volume control 
alternative (AppleCD 
Audio Player) 13 

E 

Easy Install dialog box 
for customizing installation 45 
for reinstalling CD-ROM software 

from CD Setup floppy disk 47, 
48-49 

from system software CD 43 
Edit menu (Slide Show Viewer), 

for copying and pasting 
Photo CDs 39 

Eject button 
in AppleCD Audio Player 12, 13 

keyboard alternative for 13 
in CD Remote 20, 21 

ejecting a CD-ROM disc 5-6. 
See also Eject button 

elapsed time, displaying 
in AppleCD Audio Player 12 
in CD Remote 24 

electrical safety 7 

Enter key, as Play/Pause button 
alternative (AppleCD 
Audio Player) 13 

environmental specifications 63-64 
error messages. See also troubleshooting 

for CD-ROM disc 56 
in programs for opening 

Photo CD images 36 
Extensions folder, installing QuickTime 

software in 
from floppy disk 52 
from system software CD 51 

Extensions folder window, checking 
QuickTime version in 50 

F 

FCC Class B compliance vi 
file formats 2 
File menu (AppleCD Audio Player), 

Close 19 
File menu (CD Remote) 

Close 26 
Get Info 20 
Quit 26 

File menu, ejecting disc from 5 
File menu (Extensions folder), 

Get Info, for QuickTime 
software version 50 

File menu (Slide Show), Save a Copy 40 
File menu (Slide Show Viewer), 

Preferences 36 
file sharing 

ejecting a disc and 5 
over network 8 

floppy disk 
copying Photo CD images to 33, 39 
copying Slide Show movies to 40 
reinstalling CD-ROM 

software from 46-49 
reinstalling QuickTime 

software from 52 



Foreign File System 
Apple Photo Access in 42 
formats requiring 44 

"frozen" system 59 

G 

Get Info (File menu) 
in CD Remote 20 
for checking QuickTime version 50 

graphics, Photo CDs as source of 28 

H 

hard disk 
copying Photo CD images to 33, 39 
copying Slide Show movies to 40 

hardware 
audio 9 
Photo CD 29 
specitications 61, 63--64 

headphones, problems with 57 
Hierarchical File System (HFS) 

flle format 2 
High Sierra fi le format 2 

problems using 56 
reinstalling software for 44-45 

humidity specifications 63 

I, J, K 

index to Photo CDs 32 
indicator lights, choosing color for 

(AppleCD Audio Player) 16 
inserting a CD-ROM disc 4-5 
installation of CD-ROM software, 

checking for 3 
ISO 9660 file format 2 

problems using 56 
reinstalling software for 44-45 

L 

Left Arrow key, as Previous 
track button alternative 
(AppleCD Audio Player) 13 

lens, cleaning 6 
lights, choosing color for (AppleCD 

Audio Player) 16 

M 

Macintosh desktop, At Ease 
instead of 54 

maintenance 6, 7 
marking audio tracks 23 
memory requirements, for viewing 

Photo CDs 29 
problems caused by 32, 58, 59 
and resolution, 37 

microphone, problems with 58 
modes supported 62 
mul tisession Photo CD discs 28 
music. See AppleCD Audio Player; 

CD Remote 

N 

networks, sharing CD-ROM discs on 8 
audio and 8, 57 
ejecting problems 5 

Next track button 
in AppleCD Audio Player 12, 13 

keyboard alternative for 13 
in CD Remote 20, 2 1 

"no disc" message, in CD Remote 20 
noise specifications 63 
Normal mode, in AppleCD 

Audio Player 14 
Track Edit window in 15 
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0 

Open/Close button, on CD-ROM drive 4 
troubleshooting 56 

opening the AppleCD Audio Player 
window 10 

opening the CD Remote window 10-11 
opening a Photo CD image 33 
Options menu (AppleCD 

Audio Player) 16 
order of play, in AppleCD 

Audio Player 14 

p 

Paste (Edit menu), in Slide Show 
Viewer 39 

pasting Photo CD images 33, 39 
Pause button. See Play/Pause button 
"PCD" icons 30 

opening Photo CD window with 31 
Performa computers 

reinstalling CD-ROM software on 49 
reinstalling QuickTime 

software on 50 
PHOTO_CD folder 31 
Photo CD icons ("PCD" icons) 30 

creating 30 
opening Photo CD window with 31 

Photo CD image icons 32 
Photo CD images. See also Photo CDs 

copying and renaming 33 
copying from Slide Show movies 39 
going to 35 
problems using 58-59 
transferring to another program 37, 38 
viewing 30-33 

choosing resolution for 32 
memmy and 29, 32, 58, 59 
problems with 58, 59 
in sequence 34-35 
setting preferences for 35-36 

working with in other programs 37-39 

Photo CDs 27-40. 
See also Photo CD images 

adding to (multisession discs) 28 
capacity of 28 
compatibility with CD-ROM drive 

1, 3 
defined 27 
ISO 9660 file format and 2 
memory requirements for 

29,32,58,59 
modes supported 28, 62 
obtaining 28 
reinstalling software for 44-45 
software requirements for 

3,29.42, 50 
troubleshooting 58-59 
uses for 28- 29 
viewing icons of 32 

Photo CD window 31 
photographs, conve1ting to 

Photo COs 28 
Photos folder 31 

choosing reso lution in 32 
Photos menu (Slide Show Viewer), 

for transferring image 38 
physical specifications 6 1-62 
Play button. See Play/Pause button 
playing modes, in AppleCD 

Audio Player 14 
Track Edit windows for 15 

playing music. See AppleCD 
Audio Player: CD Remote 

playing time 62 
viewing, in AppleCD 

Audio Player 18 
Play List, creating 

in AppleCD Audio Player 17- 18 
in CD Remote 24-25 

Play/Pause button 
in AppleCD Audio Player 12 

keyboard alternative for 13 
in CD Remote 20 
checking status of 57 



power specifications 63, 64 
Preferences (File menu), in Slide Show 

Viewer 36 
image transfer and 38 

Previous track button 
in AppleCD Audio Player 12, 13 

keyboard alte rnative for 13 
in CD Remote 20, 2 1 

p1inting Photo CD images 33 
Program button, in CD Remote 22, 23 
Program mode 

in AppleCD Audio Player 14 
Track Edit window in 15 
using 17- 18 

in CD Remote 23 
program requirements. 

See software requirements 
programs 

a 

adding or removing in Sbde Show 
Viewer 36 

transferring Photo CD 
images to 37, 38 

QuickTime 1.6.1, for Photo CD viewing 
3,29,50 

QuickTime floppy disk, installing 
QuickTime extension from 52 

QuickTime movie, Slide Show as 34 
QuickTime software 

checking installation and 
version of 50 

for Photo CD viewing 3, 29 
reinstalling 

determining need for 50 
from CD 51 
from floppy disk 52 

system software version and ix-x 
version required 3, 29, 50 

Quit (File menu) 
in AppleCD Audio Player 19 
in CD Remote 26 

quitting AppleCD Audio Player 19 
quitting CD Remote 26 

R 

radio interference vi 
random order, playing audio tracks in 

in AppleCD Audio Player 14 
in CD Remote 24 

read-only memory (ROM) 1 
recording from audio CDs, problems 58 
reinsta ll ing CD-ROM software x, 4 1- 52 

from CD Setup floppy disk 46-49 
on Performa computers 49 
specific parts of 44-45, 47-49 
startup problems after 54-55 
from system software CD 42-45 

reinstalling QuickTime software 
determining need for 50 
from CD 51 
from floppy disk 52 

remaining time, displaying 
in AppleCD Audio Player 12 
in CD Remote 24 

remote control. See CD Remote 
renaming an audio track, in 

CD Remote 24, 25 
renaming a CD-ROM disc 24 
renaming a Photo CD image 33 
Repeat button 

in AppleCD Audio Player 14 
in CD Remote 22-23 

resolution of Photo CD image 
choosing 32 
described 37 
display problems and 32. 58, 59 
memory requirements for 29 

restarting the computer 59 
Right Arrow key, as Previous track 

button alternative (AppleCD 
Audio Player) 13 

ROM (read-only memory) I 
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s 
safety considerations 

CD-ROM discs 7 
CD-ROM drive vii, 6-7, 55 

Save a Copy (File menu, Slide Show) 40 
Scan backward/Scan forward buttons 

in AppleCD Audio Player 
12, 13 

in CD Remote 20, 21 
screen display problems, 

with Photo CDs 58 
scrolling through Photo CDs 35 
SCSI bus burst rate 62 
SCSI ID number, for AppleCD 

Audio Player 16 
selecting a track 

in AppleCD Audio Player 11 
in CD Remote 19 

service and support 59 
Shuffle button (CD Remote) 

22,24 
Shuffle mode (AppleCD 

Audio Player) 14 
Track Edit window in 15 

shutting down computer, 
CD-ROM drive and 6 

Simple Text 
image file size and 37 
increasing memory for 29 
opening a Photo CD in 33 

Size pop-up menu 
for copying Photo CD 

images 39 
for transferring Photo CD 

images 38 
Slide Show 

in Photo CD window 31 
playing 34-35 

Slide Show icon 34 
Slide Show movies 

copying to another disk 40 
copying and pasting 

images from 39 
playing 34-35 

Slide Show Viewer 
in Photo CD window 31, 34 
Photos menu, for transferring 

images 38 
setting preferences in 35-36 
using 34-35 

Slide Show Viewer icon 34 
opening 35 

software requirements. See also 
CD-ROM software 

CD-ROM file formats and 2 
checking system software version 45 
for high-resolution 

Photo CDs 37 
for Photo CDs 3, 29, 42,50 
system software ix-x 

sound. See AppleCD Audio Player; 
CD Remote 

Sound control panel, checking audio 
source in 57 

sound input port 58 
Sound option (AppleCD 

Audio Player) 16 
sound output port 57 
Space bar, as Play/Pause button 

alternative (AppleCD 
Audio Player) 13 

speakers 
audio channel buttons for 22 
problems with 57 

specifications 61-64 
starting audio CD software 10-11 
StartUp CD Drive (Options menu) 16 
startup problems 54-55 
Stop button 

in AppleCD Audio Player 12 
keyboard alternative for 13 

in CD Remote 20 
support 59 



System Folder 
Photo CD requjrements in 3 
reinstalling CD-ROM 

software in 
from a CD 42-45 
from a floppy rusk 46-49 
on Performa computers 49 

reinstalling QuickTime software in 
from QuickTime floppy disk 52 
from system software CD 51 

System 7 file-sharing feature, 
CD-ROM discs and 8 

System 7. 1.1 , CD-ROM and QuickTime 
software and ix 

System 7.1.2, CD-ROM and QuickTime 
software and x 

system software 
checking version of 45, 48 
version requirements ix-x 

system software CD 

T 

reinstalling CD-ROM software from 
42-45 

reinstalling QuickTime 
software from 5 1 

starting computer from 54-55 

Teach Text 
image file size and 37 
increasing memory for 29 
opening a Photo CD in 33 
resolution problems in 37 

television interference vi 
temperature specifications 63 
Time button (CD Remote) 20, 21, 22,24 
time display, in CD Remote 20, 21 
Track Edit button (AppleCD 

Audio Player) 15 

Track Erut window (AppleCD 
Audjo Player) 15 

creating a Play List in 17-18 
Track Elapsed Time option 12 
track icon, playing auruo tracks 

by operting 18, 57 
track number display, in 

CD Remote 20, 21 
Track Remaining Tin1e option 12 
tracks. See audio tracks 
Tracks pop-up menu (AppleCD 

Audio Player) 14 
Track and time display 

in AppleCD Audio Player 12 
in CD Remote 20,21 

transfer rates 62 
troubleshooting 53-59 

audio CDs 57-58 
CD-ROM ruse icon not on desktop 55 
CD-ROM discs 55-56. 

See also specific types 
CD-ROM drive won't open 55 
desktop problem 54 
disc ejected by computer 56 
disc format problems 56 
ejecting a shared CD-ROM ruse 5 
"frozen" system or "bomb" 

message 59 
headphones 57 
High Sierra discs 56 
installation and 53 
ISO 9660 discs 56 
memory problems 58 
microphone 58 
Photo CDs 36, 58-59 
sound input port 58 
sound output port 57 
speakers 57 
startup problems 54-55 
warranty considerations 59 
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u 
Up/Down Arrow keys, as Volume control 

alternative (AppleCD 
Audio Player) 13 

v 
ViewNiew As (Photos menu, 

Slide Show Viewer), for 
transfening image 38 

Volume control 
in AppleCD Audio Player J2, 13 

keyboard alternative for 13 
in CD Remote 20, 2 1 
checking adjustment on 57 

w,x, y 
wananty considerations 59 
Window Color (Options menu), in 

AppleCD Audio Player 16 

z 
zero display, in CD Remote 20 
zoom box, in CD Remote 22 
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